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i t wasn’t that long ago that if you 
wanted to see how your photos 
“came out,” you had finish up 

the roll and have it sent away to be 
developed—unless you were lucky 
enough to live near an expensive one-
hour service. And if you wanted to make 
a copy of your images or other artwork 
for collage work, you had to find a copy 
center and pay a dollar or more for each 
color page.

Now we can do all this electronically 
in our own homes and studios, making 
photo collage and digital art easier, less 
expensive, and more creative than ever. 
In fact, there are so many techniques 
you can use to make a digital collage 
that some guidance from the pros is very 
welcome.

In our free eBook, Cloth Paper 
Scissors Presents 4 Free Digital Art 
Tutorials: Creating Digital Artwork 
for Photo Collage, you’ll find four 
tutorials on using photography in your 
artwork. From the basics of using photo-
editing software to turning your photos 
into a mixed-media collage, we have 
your bases covered.

In “Pixel Perfect: Fun with Digital 
Collage,” Marie Otero takes you through 
all the basics of photo editing and digital 
collage, including scanning, layering, 
filtering, and fundamental terminology. 
Even if you don’t know a dpi from a gif, 
Marie’s tutorial will get you started.
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Chrysti Hydeck takes digital photo art 
techniques a step further in  
“Art-Ography: Enhance Your Work with 
Digital Art.” She walks you through 
the photo editing process and shows 
how you can combine your photos with 
scanned backgrounds to create digital 
collages that simulate transfers. Best of 
all, you can use your images again and 
again, in unlimited combinations.

In “Branching Out with Digital Prints,” 
Kathyanne White explains how she 
prints her own digital photos on 
Lutradur® and lace paper, with the 
help of a substrate prep called Digital 
Ground. Then she cuts the printed pages 
into pieces and layers them onto copper 
mesh, wire, and hardware cloth to make 
unique abstract collages.

Mixed-media fabric collages take on 
new life—with new possibilities—when 
you use digital photo art. In “Printable 
Cotton Collage,” Jane Davies explains 
how to manipulate your own or 
copyright-free images in Photoshop® 
and print them on cotton. She then 
shows how to and bring them together 
with paper, fabric scraps, and other 
collage elements, finally altering the 
collage with paint and matte medium.

The world of digital artwork and photo 
collage is growing and expanding 
every day. If you haven’t begun, this 
free eBook is the perfect place to start. 
If you have explored digital media 
design or photo collage artwork and 
are looking to do more, Cloth Paper 
Scissors Presents 4 Free Digital 
Art Tutorials: Creating Digital 
Artwork for Photo Collage will give 
you the tools to take your photo/collage 
art to new creative heights.

Enjoy!

Jenn Mason 
Editor, Cloth Paper Scissors clothpaperscissors.com

Where mixed media 
artists come to play
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pixel
perfect
Fun with digital collage

Adapted from 
Cloth Paper Scissors® 
Spring 2005

by Marie Otero twelve months ago when I moved 
from Delaware to Charlotte, North 

Carolina, I mourned the loss 
of my big, rustic basement 
studio. But what I have 
gained in my new, tiny, 
indoor studio is a place to 
hook up my computer, my 
scanner, and several trusty 
printers––all right next to 
my workbench, which is, 
as always, resplendent in 
layers of papers, scraps, 
and paint. Having my 
computer and all the 
electronic gadgets right 
beside me is an excellent 
trade-off; not a day goes 
by that I do not scan, print, 
re-size, or digitally fiddle 
with some piece of art that I 
have created.

“Seek the Unusual”—an original 
mixed-media canvas worked with 
paper, fabric, acrylics, and pastels.

m at e r i a l s
•	Computer

•	Scanner

•	Printer

•	Photo-imaging software

•	Favorite photographs, original 
collages, copyright-free pictures, 
vintage images 

4  Free Digital Art Tutorials presented by
3  

clothpaperscissors.com
©Interweave Press LLC



The quality of your digital art will 
depend on the quality of the images 
that you use to compose it. Before you 
begin, learn the basics of your scanner, 
printer, and digital software. Think about 
the output of your piece: do you plan 
on it being used for the Internet, being 
printed, or both?

In this article, I’ll show you an easy way 
to create a digital collage by taking a real 
collage, scanning it into your computer, 
and adding images and text. 

the digital  
collage
collage it 
To begin you will need a collage. You 
can use something you have made 
previously, or create a new collage 
for this project. For my collage “Seek 
the Unusual,” I created a collage on 
canvas that I happily gessoed, painted, 
and glazed. I incorporated strips of 
plain muslin, tissue, and other collage 
papers for dimension and texture. I also 
added some numbering and letters in 
permanent black ink for interest.  

scan it 
Following the steps necessary on your 
system, scan your collage at the correct 
dpi and dimensions and save it as a TIFF 
file.

tip Before scanning you need to decide the 
final dimensions of your digital collage (for 
example, 4" × 6") and the correct dpi. Correct 
dpi is based on the end-use of the art (72 dpi 
for online work, 300 dpi for printed work.) I 
scanned my collage at 100% of its actual size 
(4" × 6" ) at 300 dpi. You must scan your 
art at the correct dpi and dimensions or your 
image will be blurry.

layer it 
Once your collage image is open as a 
file in your digital software, you can 

add imagery or text to the original 
artwork by using a series of “layers.” 
Simply stated, layers are like parts of a 
sandwich with the added advantage of 
being able to make some layers more or 
less transparent than others. You can 
add one layer right on top of another to 
create a single, more complex image. 
For simplicity, you can name your 

layers. The first or bottom layer could be 
labeled “background,” the second layer 
could be “ballerina,” with each layer 
being created successively over the other 
and manipulated to achieve the desired 
effect. This enables you to manipulate 
each layer independently, thus not 
changing the content on the rest of the 
layers. 

Further depth and interest was created for the original canvas with the digital addition of a 
monochromatic ballerina whose red heart was preserved with hand coloring and layering 
techniques in Photoshop.
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tip Duplicate a layer before launching on 
a series of filters and alterations. Then, 
if you find after many edits and changes 
that you want to return to where you 
began, you can do so with ease.

filter it 
Not only can you simply overlay other 
images and text onto your original 

artwork, you can also change colors, 
apply filters, or simply cut and paste 
different pieces, giving your artwork a 
whole new look. For instance, a piece 
that was originally red and yellow can 
become blue and green, black and white, 
or sepia-toned. Filters and special effects 
in your graphics program offer you a 
world of opportunity and excitement to 
change and alter a piece at will, without 
changing the general composition. 
They are like placing a screen, a colored 
window, or a glaze effect over your 
collage. Many filters come standard with 
graphics software, but there are also 
secondary filters that can be bought or 
downloaded as freeware off the Internet 

and uploaded quite safely into your 
software programs.

tip Keep notes as you make edits and 
changes to the layers so you can easily 
duplicate interesting results on other 
pieces of the collage or even on other 
digital collages.

images for  
digital art
Where do you find the stuff that makes 
digital art cool? Having your own stock 
of images to use in your digital art is a 
great asset. I have a huge collection of 
vintage postcards and paper ephemera 

Most graphics programs offer the opportunity to alter the color balance of 
your scanned image, enabling you to produce a stunning new look with 
little more than a click of your mouse.

A simple way to achieve the black-and-white effect is to “desaturate” the 
image, thereby removing all color. As the ballerina’s heart is the focal 
point of the piece, the color for this is preserved in a separate layer of the 
“art sandwich.”

A fun thing you can do with your 
digital collages is to turn them into 
your signature Artist Trading Cards 
(ATCs). Simply size them down to 
2.5" × 3.5", laminate, and voilà: 
your own artistic calling cards.
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that I constantly scan and use. There are 
also copyright-free stock photo sites on 
the Internet that allow you to download 

pictures for use in your work. Of course 
you can capture your own images on 
your personal camera (be it film or 
digital), which is actually an excellent 
way to amass a collection of copyright-
free pictures to use in your work.  You’d 
be surprised how useful the images of 
bare winter trees or spring flowers in 
bloom from your garden can be!

software 
Experimenting with digital art software 
isn’t as expensive as it sounds. The latest 
PC and Mac computers usually have 
word processing or graphics programs 
installed that you can play with. There 
are plenty of mid-range software 
programs that will run happily on your 
home computer: Photoshop Elements, 
Print Shop, Print Master, ARCSoftware, 
to name a few, as well as the name 
brand programs that come with your 
digital camera. All of these programs 
will enable you do a modest amount 
of editing and formatting, too. Paint 
Shop Pro comes with many tools and 
tricks similar to those in Adobe 
Photoshop, but for those who are 
serious about their digital art, 
the expense of software such as 
Adobe Photoshop (CS and 7.0 are 
the current versions) is probably 
worth it in the long run.  

final note
I have many friends who profess 
to being consistently befuddled 
by all the options out there for 

definitions
DPI (dots per inch, or pixels per 
inch) is a measurement of the output 
quality of an image, and refers to 
the resolution of images on a screen 
or printed page. The more dots, the 
better the resolution.

Pixels are the picture elements 
which make up an image, similar to 
grains in a photograph or dots in a 
half-tone. Each pixel can represent a 
number of different shades or colors, 
depending on how much storage 
space is allocated for it. Sometimes 
the preferred term is pixels per inch 
(ppi), as it more accurately describes 
the digital image.

JPEG is the abbreviation of Joint 
Photographic Experts Group file 
format, which is a compression 
“recipe” for condensing the size 
of image files. JPEGs are helpful in 
allowing access to full-screen image 
files on-line because they require less 
storage and are therefore quicker 
to download into a web page. 
This is generally the best format for 
photographic images being used on 
the Web.

TIFF stands for Tagged Image File 
Format, typically used for saving 
files to be used in print applications 
because they are uncondensed and 
lose no quality in the file-saving 
process, unlike JPEGs.

GIF is Graphic Interchange Format file 
format, typically used for saving files 
to be used on Web pages because 
it employs an efficient compression 
method and allows the image to 
be represented with a transparent 
background.

digital art and are afraid to incorporate 
it into their world of mixed media. My 
honest counsel is just “load it and play.” 
Fiddle with it, mess with it, and see what 
it can do, because no option is wrong, 
and each time you will end up with a 
composition that is both fascinating and 
different.

So whether you’re importing artwork 
that you have created and adding 
finishing touches, or are creating a new 
work on the computer and printing 
it out to use in another piece, digital 
manipulation creates endless and 
exciting options; the limits are really 
only set by your imagination.

note Creating digital artwork  often requires 
a large amount of working memory (RAM), so 
unless you have a fairly up-to-date computer 
system, many of the graphic software programs 
will seem like they are running like turtles. 

Marie Otero is a self-taught mixed media and 
digital artist with a penchant for photography. 
Visit her website: marieotero.com.

“Going Blue”—application of a blue 
filter across the base layers of the scan 
results in yet another new and different 
look. The tools in your graphics 
program really make endless options 
for creating exciting changes in your 
artwork without permanently altering 
the content of the original work.
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by Chrysti Hydeckart-ography
enhance your work 
with digital art

Adapted from 
Cloth Paper Scissors® 
January/February 2009

mention digital art to a group 
of artists and at least one 

person will  proclaim, “There is no 
way I could ever do that.” When 
using a computer to create, an 
intimidation factor comes into play 
that even some of the most creative 
minds are reluctant to tackle. It’s 
very easy to understand why. Open 
any graphics program and you 
are immediately bombarded with 
unfamiliar terminology, controls, 
and options that most of us would 
find confusing, or at the very least 
overwhelming.

But digital art doesn’t have to be that 
complicated. Often, the most difficult 
step is simply starting. As with any 
other medium of art, you don’t start out 
creating complex pieces. You take baby 
steps, you practice, and as your comfort 
level and confidence increase you take 
on new challenges. With digital art, 
mistakes can easily be fixed, supplies 
aren’t wasted, and when all else fails 
you can revert back to your original 

image. No harm, no foul. Think about 
each step individually, versus focusing 
on the big picture, and suddenly it’s not 
quite so scary. Take a few moments to 
familiarize yourself with the basics of 
your preferred graphics program. Use 
Internet search engines to find easy-
to-follow tutorials. Familiarize yourself 
with what I think is the most critical 
step any digital artist should use—
layers. They are a perfect starting point 

The result of the photo and journal layers mixed together.  
I now have a lovely, artistic photograph, or a background for future use. 
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and the fastest way to obtain the creative 
results you crave. Marie Otero wrote 
a fantastic primer on layers in Issue 
2 of Cloth Paper Scissors, and it’s an 
excellent place to begin. Another great 
reference is Gloria Hansen’s two-part 
article: “Digital Design Principles” in the 
June/July and August/September 2008 
issues of Quilting Arts Magazine. 

why create 
digitally?
As a mixed-media artist, I rely on images 
to tell stories in my paintings. I love what 
I do, and creating has always been very 
fulfilling for me. Yet, solely depending on 
stock and copyright-free images held me 
back; a part of me never felt like my work 

was completely my own. I craved to be 
raw with my work. I wanted it to be more 
organic. In my soul, I needed to feel as if 
I owned each element. 

Enter photography—or, as I like to call 
it, Art-ography. By taking and processing 
my own photographs, I can incorporate 
these images into my artwork. I am 
free of the hassles that come with 
researching copyright, and my work has 
been transformed into something far 
richer, far more personal. With the help 
of my scanner and computer I can easily 
process my images to look like vintage 
photos, re-color or crop them, combine 
them with my handmade works, and 
much, much more. Simply put, I can 
customize an image to suit any one 
of my needs. Just one photograph can 
yield thousands of spectacular results. 
Digital art opened doors for me, and I’m 
convinced it will for you, too. 

texture tricks
Now, let’s play with textures and layers. 
The following effects were all achieved 
using basic steps and playing with layer 
blend modes. Try these techniques 
alone, or combine them to see what you 

end up with. For these demonstrations 
I chose my mixed-media artwork to use 
as textures, but I often use photos of 
pavement, scans of paper, and close-ups 
of plaster walls to add interest to an 
otherwise boring photograph. Lower the 
opacity of the different layers, adjust the 
hues, and experiment a bit to see what 
provides you with the results you like.  

creating a 
dreamworld
1.	 Using an original, unedited photo, 

duplicate it and create a new layer.  

2.	 Select the new layer, and use the 
Gaussian Blur filter at a radius 
of 30. This adds a nice, ethereal 
quality to photographs, gives them a 
painted feel, and makes details pop. 
Experiment with the blur radius for 
different results.

3.	 Set the layer mode to multiply, with 
an opacity value of 75. I also decided 
to increase the brightness and 
contrast on that same layer.

4.	 Create a third layer. I used a scan 
of an old piece of paper for texture 

Original photograph (see Creating a Dreamworld instructions). Scan of a background I painted in my mixed-media journal. I re-sized the 
scan to fit my photograph (left) and set the journal page as a new layer. 
The blend mode chosen was overlay, with an opacity of 85.

m at e r i a l s
•	Camera 

•	Photos and scans of  
copyright-free textures or 
backgrounds for use in your art

•	Computer

•	Graphics editing software with 
layering capability 

•	optional

•	Scanner and printer
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and increased the saturation on that 
layer, to bring out the golden tone.

5.	 I experimented with the blend 
modes. I chose soft light and left the 
opacity at 100.

faking a transfer
1.	 Take an original, unedited photo, 

convert it to black-and-white and 
increase the contrast. 

2.	 Scan a piece of your art and add it as 
a second layer. I set the blend mode 
to multiply; the opacity was left at 
100 percent.

3.	 The final result is of the two images 
merged together. You get the effect of 
a gel transfer, without all the mess! 

note: You can combine the basic techniques 
mentioned in both previous examples. I 
experimented with different blend modes and 
opacity levels, and I duplicated the original 
picture several times.  

more layer ideas
•	 Duplicate your photo and make 

several new layers of the same 
picture. Make one layer black-and-
white; give another layer a sepia 
tone. Experiment with the blend 

modes and the opacity levels and see 
how it affects the toning.  

•	 Layer different photos on top of one 
another to create a digital collage, or 
mimic a double exposure.

These are merely jumping-off points; 
where you take them is entirely up to 
you. Give yourself permission to play. 
Practice and experimentation are the 
key to success!

how to use 
your images
•	 Start a photo-a-day project. At the 

end of your pre-determined time 

period (a week, a year, a month), 
create a handmade book using your 
prints.

•	 Use one of the many online printing 
services. Turn your work into t-shirts, 
gallery-wrapped canvases, postcards, 
bookmarks, wall clings, and more.

•	 Use digitally altered photos of your 
pets and children in lieu of vintage 
counterparts.

•	 Just journal, baby! Journals are the 
perfect place to store snapshots of 
your life. Print them as a photo, 
transfer them, gesso and paint over 
them—there are lots of options. 

Above: Original photograph  
(see Faking a Transfer instructions).

Above right: Scanned art for the second layer.

Right: The two images merged together.
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•	 Print photos onto fabric paper and 
create a cloth book, pillow, quilt, or 
tote bag.

•	 Print onto canvas or fine art paper, 
and then mount it on a piece of wood. 
Embellish, add paint, and seal it with 
beeswax.

•	 Crop, print, and mount to an ATC-
sized mat board so you’ll always have 
art on hand you can trade!

texture 
mania 
Despite the fact that there is an 
abundance of free textures offered on 
the Internet, creating your own allows 
you the freedom to use them without 
restrictions and often yields a better 
quality image to work with. 

Textures are all around you. They are 
the often overlooked fragments that 
give our lives character. Go on a texture 
scavenger hunt to see what you can 
discover. Be open to the possibility of 
unexpected beauty. 

tip: Be sure your digital camera or scanner is 
set to take the highest quality photo/resolution 
it will allow. This will give you greater 
flexibility in using it. 

favorite textures
•	 Cracked sidewalks and pavement

•	 Old baking trays and cookie sheets

•	 Painted or drawn backgrounds

•	 Papers: handmade, stained, wrinkled

•	 Vintage lace, organza, linen

•	 Old book covers, tile, dirty glass

•	 Stucco or plastered walls

•	 Blurred light and scenes

•	 Anything rusty and crusty

•	 Chipped and peeling paint

•	 Carved tree trunks

•	 The backs of old tombstones 

Subtle textures tend to produce the best 
effects; while a bold image can be used 
successfully, it will often dominate a 
photograph. A crumpled-up, old piece 

of paper tends to complement a picture 
rather than overpower it. 

Chrysti Hydeck is an artist, writer, 
photographer, and instructor. Visit her  
website: christyhydeck.com.

take action
Adobe® Photoshop® has this wonderful, popular little feature that I have yet to 
see elsewhere: Actions. Actions can be created and downloaded for free, or they 
can be purchased. Though I am a thrifty kind of gal, it is the Action sets I have 
purchased from Nichole Van Photography that have become indispensable to me. 
Her sets are skillfully made, work correctly (something a lot of free Actions don’t), 
and she offers a variety of artistic photo finishes. The license allows me to use 
them in a professional capacity and the unique sets also give me some control for 
customizations, a trait I find essential. After all, as no two photographs are the same, 
why would I want to treat them as if they were? Her step-by-step prompts help me to 
further my Photoshop education, and the results are often breathtaking.

Still not convinced? Have a look!

These edits took just a few minutes to perform, and the results shown barely scratch 
the surface of what Actions can do. If you have wanted to venture into digital art and 
photo editing, Actions are the perfect place to start.

Original, unedited photo.

I used Nichole Van’s Tilt Shift + Color Texture 
Action, then ran her Green Acid Tint Action 

followed by her Vignette Action.

I de-saturated the image and added my own 
film texture and vignette for a softer, vintage 

look.

I cropped the image slightly, then used 
Nichole Van’s Outdoor Color Pop Action.
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branching out
 with digital prints
by Kathyanne White

Adapted from 
Cloth Paper Scissors® 
September/October 2008

4  Free Digital Art Tutorials presented by
11  

clothpaperscissors.com
©Interweave Press LLC



For years I have printed on  
ready-to-print fabrics with great results, 
and more recently I have branched out 
to other substrates. My experiments 
have led me to such surfaces as 
Lutradur, lace paper, vellum, watercolor 
paper, handmade paper, transfers, and 

substrates that I created myself to 
express the forests that I so love.

working  
with lutradur
Lutradur is a spun-bond web material 
that was originally created as a roofing 
product. Artists are now using it for 
many different applications. I discovered 
it while searching for a way to obtain a 

quality digital print that could be pieced 
into my art quilts. Today, I use Lutradur 
in many forms in my mixed-media 
artwork and journals. I use a  
heavier-weight version of Lutradur 
when I want a vivid print, coating the 
surface with Golden’s Digital Ground 
White before printing. For printing on 
the lightweight version, I use Golden’s 
Digital Ground Clear, which allows the 
airy look to show through the print. 

m at e r i a l s
•	Rubber gloves

•	Plastic to protect your work surface 
and drying area

•	Foam brushes

•	Digital Ground Clear (Gloss) or 
Digital Ground White (Matte) 
coating from Golden® Artist Colors

•	Lutradur®, in chosen weight

•	Lace paper

•	Inkjet printer

•	Carrier sheets, the size of the print 
you will be making (See “printing 
on lace paper,” Step 5, for more 
information.)

•	Double-faced tape (I use Scotch® 
brand.) Do not use a good, 
permanent kind of adhesive tape 
that makes it difficult to lift the 
paper from the carrier sheet.

•	An inkjet printer (I use printers 
through which the paper makes 
a direct pass, such as the Epson® 
R2400.) 

note: You will need to experiment 
with your printer to see how to get 
the best results. Some printers have 
what are called pizza wheels to 
transport the paper through the 
printer. If this is the case, you will 
only want to use the Digital Ground 
White (Matte) coating, since other 
coatings may leave marks in the 
printed image. 

my visits to forests all over the world—full of some of the largest trees on 

the planet—have been some of the greatest experiences in my life. I 

was inspired to use my pictures and images of these forests in my artwork, and 

these photographs of trees and their surroundings have transformed into a series 

of work that depicts my response to the rich environment of these special places. 

Experimenting with surfaces, then printing them on an inkjet printer, allows me to 

add texture to enhance my artwork.

Above (detail) and previous page: “El Capitan” 
• 15" × 15" • This piece is composed of five 
digital prints layered with copper mesh and 
assembled on hardware cloth with copper wire.
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This thinner Lutradur can also be easily 
distressed and distorted with a heat tool 
for added interest. 

printing on lutradur
1.	 Cover your table with plastic. Stack 

2 pieces of Lutradur on the plastic 
covering, making sure there are no 
creases in the Lutradur. I like to 
layer the Lutradur since it is porous 
and some of the coating will seep to 
the bottom piece, wasting less.

2.	 Read the manufacturer’s directions 
with Golden’s Digital Ground 
White (Matte) for use and the safety 

precautions. Wearing rubber gloves 
and using a foam brush, coat the top 
surface in one direction. Once dry, 
coat the surface with a second coat 
in the opposite direction.

3.	 Once coated, carefully remove the 
wet Lutradur from the plastic and 
pin up to dry on a plastic-covered 
piece of wall board or similar surface. 
Be sure to cover the drying surface 
with plastic since the wet Lutradur 
can stick to other surfaces. 

note: Don’t rush the drying process. I always 
wait overnight before I print; if the surface is at 
all wet, it could damage your printer.

4.	 When it’s dry, trim the Lutradur to 
the desired size for printing. 

5.	 Print your surface. Lutradur can be 
sent through the printer without a 
carrier sheet, but you might want to 
hold the Lutradur as it starts its pass 
through the printer to make sure 
everything goes in correctly.

6.	 Let your print dry before using. If 
desired, you may use a spray coating 
to enhance the life of your print. 
(I have been using Krylon® Matte 
Finish. For results on spray coatings 

“Forest Surfaces 3” • 21" × 27" • This piece is composed of seven digital prints layered with aluminum screen on copper mesh with copper wire.
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for permanence visit  
wilhelm-research.com.)

printing on lace 
paper
note: Lace papers are very fragile and will 
need a delicate hand. Start with a small sample 
until you get the hang of it.

1.	 Get started as in the Lutradur 
instructions (Steps 1–2), but in this 
case use a single sheet of lace paper 
and coat the surface with Golden’s 
Digital Ground Clear (Gloss). Be 
very careful; when it is wet it is very 
fragile and can tear easily.

tip: Put the coating on in 1 or 2 light passes 
with the foam brush. Any more can damage 
the paper. 

2.	 Carefully separate the coated lace 
paper from the table and gently 
move it to a flat, plastic-covered 
drying surface. Allow it to dry before 
touching it again.

3.	 Lightly iron the paper from the 
back side, being sure to cover it 
with muslin or a Teflon® cloth so it 
doesn’t stick to your iron. The lace 
paper needs to be pressed flat to 
print.

4.	 Trim the paper to the desired size for 
printing.

note: The paper can tear when removing it 
from your carrier sheet. In order to keep your 
image intact you may want to leave a large, 
unprinted border around the image. The border 
will allow you to lift the print away from the 
carrier sheet without damaging the image; only 
the white space will be compromised.

5.	 Place double-faced tape along the 
edges of your carrier sheet. I use a 
sheet of Epson watercolor paper or 
their matte paper for a carrier sheet; 
regular inkjet paper will also work, 
but you will have to replace it more 
often since it is lighter weight. 

6.	 Lay the lace paper, coated-side up, on 
the carrier sheet and smooth it onto 
the sheet, with the edges pressed to 
the double-faced tape. You are ready 
to print.

7.	 Print the paper and then very 
carefully remove the paper from 
the tape on the carrier sheet. It is 
important to remove the print from 
the carrier sheet right after you 
print.

a word about print 
settings and color
In order to get a quality print you will 
need to adjust your print settings, 
usually using an enhanced matte or a 
matte paper setting. I do not use glossy 
paper settings for any of my work. If 
you are not familiar with paper profile 
settings, it is something that you need 
to know to get a quality print. Refer 
to your printer manual, or call the 
manufacturer of your printer. 

If you are using a program such as 
Adobe® Photoshop® or Photoshop 
Elements, always allow your photo 
program to manage your color. Color is 
very important in getting a quality print. 
I calibrate my monitors often, and I use 
Photoshop to manage my color space, 
never my printer. You can choose how 
to manage your color space somewhere 
in your settings if you are not using 
Photoshop-based software. 

Kathyanne White is a fiber and digital print 
artist who creates workshops and tutorials.  
Visit her website: kathyannewhite.com.
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printable
cotton collage

Adapted from 
Cloth Paper Scissors® 
March/April 2009

by Jane Davies

several years ago a friend sent me some printouts of Greek vase paintings, 
thinking I might incorporate them into my collage work. They sat around for 

a couple of years before inspiration struck. Then, suddenly, I became obsessed 
with Greek mythology and had to use these images somehow. First I scanned 
the images into my computer, and then I played with them in Photoshop, 
experimenting with color, size, and layering one image over another. This 
resulted in my “Greek collection,” images that formed the basis for my series of 
printable cotton collages.

m at e r i a l s
•	Scanned images: found images, 

photographs, or pieces of your own 
artwork 

•	Printable cotton fabric sheets (or 
muslin and freezer paper)

•	Computer and inkjet printer

•	Photo-editing software (I use 
Photoshop® CS3.)

•	Acrylic paint(s) and/or drawing ink

•	Spray bottle or brush and water for 
wetting fabric

•	Acrylic matte medium

•	Paper, fabric scraps, and other 
collage elements

optional

•	White glue or PVA for adhering 
heavier collage items 

•	Beads

•	Thread(s) and needle 

I discovered printable cotton (81⁄2" × 11"  
sheets of cotton fabric backed with 
stiff paper) and was excited to print my 
own fabrics to use for sewing projects. 
However, the color came out too pale 
for my liking, so I put it aside. The idea 
of using printable cotton sheets for 
collages rather than for sewing projects 
or fabric samples dawned on me one day 
when I was playing with my Greeks in 
Photoshop. I printed them out, painted 
them with acrylics, and used them with 
both cloth and paper for collage. Treated 
this way, the cotton cloth acquired an 
ancient parchment-like feel and I found 
that I loved working with it. This process 
has elements of quilting and painting on 
canvas, as well as collage, and the pieces 
can be stitched and beaded more easily 
than paper.  

In general, I create my collages with 
reproducible material or materials that 
I have in abundance. Rather than use 
an original photo, print, or scrap of 
handwriting, I like to scan it and print 
it out on paper, fabric, or other material 
to use in my work. This has three 
advantages for me: first, I can re-size, 
re-color, or otherwise manipulate the 

image in Photoshop, creating multiple 
possibilities for collage material; second, 
I can choose the material on which I 
wish to print the image—various kinds 
of papers, fabrics, or transparencies are 
some of the possibilities; and third, if 
it doesn’t come out as I planned, I can 
print the image again and start over. The 
control freak in me loves the freedom 
to manipulate color, size, and material, 
while the timid artist in me—afraid 
to wreck a good piece of paper—gives 
way to the spontaneous one only when 
I know I can re-create my materials, if 
necessary.

directions
making a collage 
on printable cotton
I suggest working on several collages at 
once, giving yourself room to develop 
themes and play with images over a 
series of pieces. You might choose to 
print out one image several times and 
develop each collage differently from the 
same starting point.
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manipulating 
     images in  
  Photoshop
play with the color 
•	Use the Hue/Saturation box by 

clicking on Image>Adjustments> 
Hue/Saturation and adjusting the 
sliders.

•	Use the Paint Bucket tool at 
various tolerances to fill areas with 
color. 

•	Use the Replace Color box by 
clicking Image>Adjustments> 
Replace Color to vary one color 
at a time.

re-size your image
•	Use the Image Size box to make  

it the appropriate size for your 
8½" × 11" substrate. Click on 
Image>Image Size, check the 
“constrain proportions” box, and 
type in the appropriate width or 
height. I usually start with 5" × 4" 
or 6" × 8". 

•	Find a composition within your 
image that you want to enlarge 
and use the Crop tool to cut out 
that chosen piece. Then use the 
Image Size box to make that 
composition the appropriate size 
for your substrate.

layer one image 
over another
•	Use the Move tool to drag one 

image on top of another and 
then reduce the opacity of the 
top image in the Layer Style 
box (double click on the layer 
in the Layers panel, and use the 
Opacity slider) so that the image 
underneath shows through. You 
may flatten the image at this 
point by clicking on Layer>Flatten 
Image, and then play with color 
and composition per above.

4  Free Digital Art Tutorials presented by
16  

clothpaperscissors.com
©Interweave Press LLC

“Fig Leaf” • 83⁄4" × 151⁄4" • “I had no idea where ‘Fig Leaf’ was going when I started, as is the 
case with most collages to some degree or another. This piece stayed at a kind of midway point for 
many days while I worked on others in the series. I tweaked it frequently, but nothing was jumping 
out at me screaming for emphasis. Finally, it occurred to me that the figure in the image was badly 
in need of a fig leaf. I found a photograph of one, scanned it, and printed it out in several different 
sizes. When I found the size that worked, I painted over it and added a little glitter for fun. I tried 
many ways of applying my fig leaf to the appropriate spot, but it just didn’t work visually. Hanging 
it off the bottom of the collage seemed to work, and then I added the top row of iridescent glass 
leaves.”



“Forest Dream” • 81⁄2" × 103⁄4" • “‘Forest Dream’ began with the black-and-white Greek image layered with blue handwriting 
and printed on printable cotton. I toned down the black-and-white contrast with pale washes of neutral colors and added strips 
of collage to the bottom of the piece—more from the ‘Greek collection.’ Then I decided to introduce another central image. In 
Photoshop I’d layered a photo of a woman with a line of trees and printed that out on cotton as well. I created the upper torso with 
a contour map of my town (I live on route 315), and suddenly the image made sense to me. The bits and pieces of collage, the 
paint, the beads, and the necklace fell into place as I contemplated dreams, forests, and a sense of place.”
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creating texture 
with matte medium
1.	Apply a generous coat of matte medium or soft 

acrylic gel to your painted and collaged surface.

2.	When almost dry, use a dull-pointed tool such 
as a knitting needle to make random marks, 
patterns, or handwriting in the medium and 
allow to dry.

3.	Rub a contrasting acrylic paint into the texture 
using a stiff brush or your finger. Immediately 
wipe the surface gently with a dampened cloth 
or paper towel, making sure to leave some of 
the paint visible in the crevices. You can repeat 
this step as many times as you like to build subtle 
layers of color and texture.

“Pedestal” • 81⁄2" × 123⁄4"  • “Unlike the pieces using Greek 
vase painting imagery, ‘Pedestal’ began with a printout of a 

small collage study I’d done a year or two ago. At first, I simply 
extended the color areas with quinacridone gold on top and 

ultramarine blue on the bottom, dividing the composition into two 
unequal parts. Then I added another image—one of my Greek 
layered images from the original series printed out on cotton—

and filled in the top background with yellow squash quilting fabric 
(from one of the fabric collections I’ve designed for Free Spirit). 

From there, I added a few more collage details, then stitched the 
beads on for a final touch.”

1.	 Take your scanned images and, 
using your photo-editing software, 
manipulate the color, size, 
composition, etc. (See Manipulating 
Images in Photoshop.)  

note: If you are not Photoshop literate, or 
are not interested in digital alterations, you 
can simply find or create an image, mount it 
on an 8½" × 11" sheet of paper, scan it, and 
then print it onto printable cotton. The result is 
your starting point and your substrate; it does 
not have to end up as the central image of your 
final collage.  

2.	 Once you have created several 
images and sized them appropriately, 
print them out on 81⁄2" × 11" 
printable cotton. 

tip: You can make plain cotton into printable 
cotton by ironing freezer paper to it and cutting 
it to 8½" × 11" to fit your printer, but I prefer 
the convenience of ready-made sheets. I do use 
plain muslin (backed with freezer paper but 
not printed) as a substrate sometimes, if I  
want a piece bigger than 8½" × 11". Then I use 
the printable cotton for collage elements. 

3.	 Wet the fabric using a spray bottle 
or a brush, and then apply washes of 
acrylic paint and/or drawing ink. Let 
it dry completely. 

4.	 Apply a coat of acrylic matte medium 
to the whole piece. Remove the 
backing when the matte medium 
is dry. Once the cotton is infused 

with acrylic matte medium, it is stiff 
enough to work on.

5.	 Now the fun begins: add paper, fabric 
scraps, and other collage elements 
to make your piece come to life 
and give it direction. I like to let 
these elements extend beyond the 
boundaries of the original 81⁄2" × 11"  
format, giving the piece a more 
interesting shape. My favorite 
materials for these collages are other 
images printed out on cotton, cotton 
quilting fabric, joss paper (available 
in Chinese markets), and heavily 
textured but lightweight papers such 
as unryu, banana leaf, and mango 
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“Silver Shoes” • 103⁄4" × 133⁄4" • “I 
began ‘Silver Shoes’ with the idea that I’d 
exploit the tree imagery in my original print. 
Trees hold such metaphorical and visual 
possibility that this seemed an inviting place 
to begin, but as the piece developed, it 
wasn’t getting any more interesting than 
simply a tree and a background. It needed 
something hanging from or sitting beneath 
the tree, but I auditioned image after image 
and nothing seemed to work. Just when I 
was about to give up on it—send it to the 
recycle pile—I decided to insert a picture 
of my grandmother (printed on translucent 
paper) that had been sitting on my 

workspace waiting for a project. 
I put her on a swing, and voilà! 
It finally came together.”

leaf. I apply my collage materials 
using matte medium as the adhesive 
as well as for the top coat. If you 
are using heavier materials such as 
cardboard or canvas, you may want 
to use white glue or PVA for the 
adhesive.  

6.	 When the main collage elements are 
in place, continue to apply layers of 

paint, texture (see Creating 
Texture with Matte Medium), 
drawing, more collage, etc., until 
you are satisfied with the piece (see 
When is Your Collage Finished?). 

7.	 Finally, when all of the collage 
and painting elements have come 
together, you may embellish the 
piece with beads, stitching, or other 
attachments. Such embellishments 
add emphasis and sparkle to existing 
features within your composition, or 

can be used to create new 
elements that make the 
piece come together.

note: If I want to stitch or 
bead on a paper collage, I back 

the desired section with fabric for 
extra strength.  

when is your 
collage finished?
Developing the collage after the main 
elements are in place is where the 
rubber meets the road, so to speak—
where the collage will stand on its own 
or remain unresolved. Some collages 
come together almost effortlessly, while 
others resist resolution and need to be 
put aside for a while. Working on several 
pieces at a time gives you breathing 
room and perspective so that you don’t 
get too attached to any one piece. Let 
each piece be what it wants to be, even 
if that means it remains unfinished for 
a while. 

Jane Davies is a collage artist, designer,  
writer, and teacher. Learn more at  
janedavies-collagejourneys.blogspot.com/.
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“Two Poppies” 
• 9" × 121⁄2" • 
“The original print 
for ‘Two Poppies’ is 
an image I created 
by layering a 
painting of poppies 
(my own painting, 
that is) with a random tissue paper 
collage I did for a demonstration. I 
love poppies, and the bright, springy 
colors contrasted nicely with the 
deeper hues I’d been using for my 
other printable cotton collages. After 
the initial washes of acrylic paints, I added fabrics from my Free Spirit collections (the greens, yellow on 
green dots, and the turquoise and green floral) and bits of another printout from my ‘Greek collection.’ I 
collaged on some scraps of paper doily to echo the doily in the original collage piece, and a scrap of joss 
paper just below the poppy stems to anchor them. Finally, I embellished it with a few beads to add a little 
sparkle.”
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